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Introduction 
The software TGTools is a set of plug-ins for Finale. They extend Finale’s capabilities by 
more than sixty new commands. These commands are available from a new menu that is 
installed in Finale’s menu bar. 
Most plug-ins do a specific job on a selected region within the document. Before selecting  
the commands, select a region with the mass mover tool. If no region is selected, they can 
automatically work on the whole score if the user so choses. 
 

Entry-oriented commands 
These commands operate on each note or rest entry separately, so that partial measure 
selections will be taken into account. 
 

Measure-oriented commands 
Measure-oriented commands will affect whole measures even if partial measures are 
selected. Currently these are most of the (beat chart oriented) Spacing Utilities. 
 

Global commands 
Globally operating plug-ins are independant of a selection. These are: Text Expression 
Sorter, Staff List Manager, the Layout Utilities, Character Set Conversion, and Font Info. 

 

Mac vs. Windows 
TGTools for Mac is almost identical to the Windows version. Missing are only the Explorer 
for Text Expressions and the Keyboard Remapper. As a substitute for first, there is ‘Select 
Expression’ on Mac. Since stand-alone macro utilities seem to be more widespread on 
Macs than on PCs, there may be no need for a keyboard remapper plug-in for Mac. 

TGTools Menu Screenshot 
This is a sample screenshot as it looks on Windows. 
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Data Security Tips 
 

Using plug-ins 
There is practically no additional risk when using plug-ins with Finale. However, you may 
want to save your documents before applying plug-ins that you don't know well yet. 

By using Finale's UNDO command, you can always undo whatever a plug-in has done.  

 

Daily backups 

For any important work that you do, whether you're using Finale or any other program, 
please make daily backup copies of your work. 

Do not reuse the same disk for your daily backup, but use a different disk each day. Of 
course, you can reuse disks after, say, a week or a month has passed. 

In addition to that, you can ultimately protect your work if you use the SAVE AS command 
to change your file name often – i.e. several times per day. This way you retain multiple 
copies and different versions of your work as it progresses.  

Especially with scores, there may be situations where you wish you could gain access to 
an older version – for example, when a Finale command that you used on a particular 
region has had undesired side-effects on the rest of the score. This is often discovered 
when it's too late. For example, moving and copying partial measures can be dangerous. 

 

 

PDKTools Helper Plug-In 
 

Language Setting 
TGTools is shipped with a required helper plug-in. PDKTools can, among others, provide 
for International English terms such as crotchet, bar, and anacrusis. If you’d like TGTools 
to use these terms in the dialogs, please set your language to International English in the 
PDKTools options (available in Finale’s plug-in menu). Other languages are not currently 
supported, even though PDKTools lists them. 

 

Other important options 
PDKTools includes these options that can determine how TGTools dialog windows 
behave. It is important to be aware that this behavior is controlled from the PDKTools 
dialog. On Windows, some of these settings can also be specified on a per-dialog basis: 

• automatic inactivation of TGTools dialogs after they have performed a task 
(“return focus to Finale”) 
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• “Collapse window when losing focus”. This option will result in TGTools dialogs that 
are not currently used to collapse so that only their title bar remains to be seen. 
Click on it to restore the complete dialog. 

 

Overview 
Explorer for Text Expressions (Windows)  /  Select Text Expression (Macintosh) 
 

Music Utilities 
• Harmonics 
• Beam Breaker 
• Tremolo 

_______________________ 

• Respell Notes 
• Accidentals 
• Fill with rests 

_______________________ 
• Create Hairpins 
• Create Slurs 
• Laisser vibrer 

_______________________ 
• Combine rhythms and pitches 
• Smart Split Point 
• Make / Repair parenthesized trill notes 

 

Spacing Utilities 
• Make/Remove space at end of measure  

(by compressing/expanding the measure's spacing) 
• Add/Remove space in measure (by making the measure longer/shorter) 

_______________________ 

• Expand/Compress spacing (for partial measures) 
_______________________ 

• Measure Widths (for empty measures or measures containing only one note, and multimeasure rests) 
• Modify a measure's leading white-space 

- helps if you experience extraneous white-space at the beginning of measures 
_______________________ 

• Remove Extraneous Beat Chart Handles 
- tidies up your beat chart for quicker manual tweaking 

• Proportionality 
- processes the measure's spacing after Note Spacing has been done to restore a certain proportionality 

 

Layout Utilities 
• Staff List Manager – powerful management tool for optimized staff systems 
• Join Two Staff Systems 
• Split Staff System… 

_______________________ 

• Before Deleting Measures 
• After Inserting Measures… 
• Fit measures – can fit measures into a given amount of systems 

_______________________ 
• Update Groups 
• Incipits 
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• Scale Staff Positions – makes differently optmized systems have a uniform height 
_______________________ 

• Shift System Optimization  
• Copy System Optimization  

– shift/copy optimization (including vertical spacing of staves) from one system to others 
 
 

 
Modify menu 

• Align/Move dynamics or other expressions with hairpins or note-attached lines 

• Playback makes hairpins, glissandi, and trills actually play back! 
_______________________ 

• Remove some Special Tools alterations, as well as convert notes to rests, or remove stems and beams. 

• Reset slur positioning and/or contour, or make hairpins horizontal over system breaks 

• Special Modifications allows individual combinations of search criteria and alteration ‘actions’ 
_______________________ 

• Rests 
- will provide for ‘classical’ rests in 3/8, 3/4, and 3/2 time signatures by splitting rests up 
- can minimize the number of rests by expanding preceding note values 

• Replace Pitches performs user-defined pitch class substitution 

• Expressions  
converts measure-attached expressions to note-attached ones, and perform other operations on expressions. 

• Slurs 
- recalculates (resets) slur contour  
- converts measure-attached slurs to note-attached ones 
- resolves collisions between slurs and articulations 

• Enclosures 
- copies enclosures between items in the expression selection list 
_______________________ 

• Shift whole notes, grace notes, and note-attached glissandi (these to avoid collisions with accidentals) 

• Transfer beat charts, measure attributes, locked measure groups, system margins and attributes, 
metatools, and measure expressions  between files, as well as within files. 

 
 

New Spacing -  runs Finale’s note spacing with some special pre- and postprocessing to achieve better 
results. Currently, it mainly takes care of common lyrics problems. More features to come. 

 

Lyrics Utilities 
• Move long syllables on beat 1 a bit to the right 

• Left-align melisma syllables 

• Shift lyrics 
Can shift lyrics in any direction. The default settings will automatically compensate for Finale's bad centering of 
syllables under whole and double-whole notes. 

• Remove lyrics adjustments and/or alignments 

• Word Extensions – corrected and revamped word extension plug-in 
 

Part Management Utilities 
• Process Extracted Parts to select one note from multi-part staves 
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• Smart Distribution of Parts distributes/explodes groups which contain multi-part staves, or which don’t 
have the parts fully separated yet due to optimized staff systems. It recognizes part specifications such as 1., 2., 
or a2 and solo. 

• Smart Explosion of Multi-Part Staves explodes staves similar to the previous command. However, it 
treats each staff a separate unit from which it extracts the voices onto multiple staves. 

• Add Cue Notes is a modified plug-in from Coda Music Technologies with a few improvements. 
• Join rests of multiple layers 
• Harp Pedaling adds pedal diagrams and labels pedal changes 

 

Miscellaneous 
• Text Expression Sorter 

• Custom Chord Styles (such as DO RE MI and Bb/H) 

• Character Set Conversion (such as Mac<>Windows) 

• Find various kinds of things including text expressions and enharmonic oddities due to possible clef confusions 

• Analyze finds parallelisms and marks all of them at once in the score! Can optionally find hidden parallelisms.  

• Compare Entries finds differences between staves within a file as well as between different revisions of a file 

• Export to spreadsheet saves note data as a text file which can be imported into spreadsheet programs 
• Import Auricle files from the film music synchronisation software. 
• Font info lists all fonts referenced in the document – whether they are actually used or not. 

 

Keyboard Remapper (Windows only) 

• remaps any key to another key or to a menu command 

• configured via the Options menu item. 

Print Multiple Files (Windows only) 

• something Macintosh users have always been able to do! 

 

 

Important Note on Finale 97/98 
Due to the many plug-ins contained in TGTools, this may exceed the limit of plug-ins that 
will work with these older versions of Finale. If you experience problems accessing 
TGTools menu items (such as no reaction), you need to remove other plug-ins that you 
don’t need from Finale’s plug-in folder. In fact, you may need to remove quite a few of 
them, until all TGTools items work. 

A better solution is in the works but not available yet. 
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Installation (Windows) 
TGTools are contained in these files : 
• TGTools(.fxt) 
• PDKTools2000(.fxt) or PDKTools9798(.fxt) 
Please copy these two files into your Plug-Ins folder, such as C:\Finale 2000\Plug-Ins. 
PDKTools is a required helper plug-in library. 
 

Installation (Macintosh) 
TGTools are contained in the file: 
• TGTools 
• PDKTools2000 or PDKTools9798 
 
Please copy these two files into the Plug-Ins folder located within Finale's main folder. 
PDKTools is a required helper plug-in library. 
 
 
 
 
 
 

TGTools Licence Agreement 
By installing and/or using TGTools, you acknowledge to have read, understood and agree 
with the following terms: 

1. One purchased copy of TGTools may normally be installed on one computer system 
only. However, you are allowed to install it on multiple computers if it is ensured that 
only one person will use it at any given time. 

2. NO WARRANTY. 

The user of TGTools can expect good software, but there is no guarantee that TGTools 
are error-free, work uninterrupted, or that they may not have unwanted side-effects on 
the operation of other programs or the computer system's stability and security. 

Tobias Giesen expressly disclaims all other warranties. 

3. This licence agreement cannot be limited, modified or extended by other oral or written 
information. 

4. NO LIABILITY. 

In no event will Tobias Giesen be liable to customer or any other party for damages of 
any kind arising from downloading, installing, or using TGTools. As soon as you follow 
the link at the bottom of this page, you take over the full responsibility for the 
downloaded program. 
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Chapter Two 
 

Music Utilities 

Harmonics - Beam Breaker – Tremolo 

Respell Notes – Accidentals – Fill With Rests 

Create Hairpins – Create Slurs – Laisse Vibrer 

Combine Rhythms and Pitches 

Smart Split Point 

Parenthesized Trill Notes 
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Harmonics Automation 
This is mainly for strings: when a harmonic is not played on an empty string, two notes are 
notated. The lower one has a normal notehead, while the upper one is a diamond. 
 
This plug-in searches the selected region for intervals of two notes. When an interval that 
corresponds to the specification in the options dialog box is found, the upper note is turned 
into a diamond. 
 
The selected region can include partially selected measures. 
 
 

Example 1 
before  ... 

 
 
and after Harmonics automation with “all theoretical harmonics“ selected: 
 

 

 
 

 
...   or 

 
TGTools Harmonics Automation automatically prepares the music for correct playback, so 
that you will here the actually sounding pitches. In addition, the sounding pitch can be 
added as a small parenthesized note. 
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Example 2 
here the option “only the specified interval (4)“ was selected: 

 

becomes 

 

 

This example shows how the harmonics to be modified can automatically found even 
within a musical context of other intervals. 

Screenshot 
 

 
 
Options 
♦ work on:  specify the intervals that should be turned into harmonics. 

All violin harmonics is currently set to thirds, fourths, fifths, and sixths; all theoretical 
harmonics are all harmonics that can be played on an empty string. 
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♦ overwrite existing notehead alterations: check this option only if you need to re-
process existing harmonics – possibly to prepare them for playback or to change the 
diamond character. 

♦ prepare for correct playback: this should always be checked, since it can do no 
harm. You will here the correct sounding pitches upon playing back the music. 

♦ diamond character number: this defaults to 79 for compatibility with Petrucci, but if 
you’re using Engraver or other newer fonts, try 225 which is a more beautiful one. 
You can differentiate between black and white noteheads, though by default a white 
diamond is added to all note durations. 

♦ add sounding pitch, size 60%: check this to have the sounding pitch added as a 
small note and specify the size percentage for it. 

♦ parenthesize: check this to parenthesize the small note that’s added as the sounding 
pitch. You can customize these with the Parentheses button. See end of this volume. 
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Beam Breaker 
This tool has two functions: breaking primary and breaking secondary beams. 
• Breaking primary beams helps you to unbeam rests, and to break up long beam groups 

on the beats, especially when shorter notes are involved (16th and smaller). 
• Break secondary beams to make beamed rhythms clearer. Your piece nomally needs 

16th-notes triplets or shorter durations for the effect to be seen. In many cases, the 
settings need not be altered. 

 

Breaking Primary Beams 

 
 >>> 

 

This music was set to a ¾ time signature equivalent to a dotted half note so that Finale 
beams the whole measure as one group. Beam Breaker will break the beam group on the 
beats in those measures where appropriate, depending on the options that you choose. 
 

Breaking Secondary Beams - Example 1 
This example illustrates the main purpose of this plug-in: there are many secondary beams 
to break here. Note that this music has Finale’s document option “Include rests in beam 

groups” on. 
becomes: 

Example 2 
This example shows an additional feature of the plug-in: simplify beamed rests can 
exclude rests from beam groups where appropriate. This is only needed when Finale’s 
document option “Include rests in beam groups” is on. 

 

 

becomes: 
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Breaking into two or three 
The most important option is whether you want to break sixtuplets into three or into two 
groups.  

Whenever 16th note sixtuplets are to be divided into two groups of three notes, then set 
the first “break into” option to 2. 

Whenever 16th note sixtuplets are to be divided into three groups of two notes, then set 
the first “break into” option to 3. 

See Options. 

 

Screenshot 
The options dialog currently looks much different on the Mac, and many of the "break into" 
options are not included since they are almost never used. They will be added later. 

 

 

Options 
Explanations of the most important secondary beam breaker options: 

♦ break groups of beamed notes whose total duration corresponds to X into y 
parts: here you specify whether, say, quarter notes are divided into two or three or any 
other number of groups. See Breaking into two or three above. 
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♦ break 

• groups of four notes in two: check this if you even want to subdivide, say, four 
subsequent 16th notes into two groups. 

• all secondary beams in each case: normally unchecked – TGTools intelligently 
determines the number of secondary beams to break. However, if you always want 
to break all secondary beams, then check this option. It's only relevant when you 
have 32nd or shorter notes. 

• tuplets of X into a+b+c+d+e: this rarely used option (currently available on 
Windows only) provides for custom subdividing of X-tuplets. 

♦ remove existing secondary beam breaks: when this option is checked, TGTools 
start the breaking of secondary beams all over, so that no existing breaks can confuse 
them. 

♦ rests are included in beam groups: it is important to check this option if and only if 
you also checked the option in Finale's document options. If this is not checked, 
TGTools have to break the first and only beam in some cases where rests are part of a 
complex rhythm. 

♦ simplify beamed rests: see Example 2 

 

 

Tremolo 
This plug-in facilitates tremolo notation.  

First, the music is entered so that it fits into the measures without tremolo. TGTools then 
convert all two consecutive identical pitches into a tremolo. The tremolo’s note durations 
are doubled: 

 

becomes: 

 

Some options enable fine-tuning tremolo notation (such as the number of beams).  

If you want to convert a specific pair of notes or chords within a measure, use Finale’s 
option Partial Measure Selection (Finale 2000: in the Edit menu). Now any pair of notes 
regardless of their duration can be selected before invoking the plug-in.  
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Respell Notes 
This plug-in will remove double sharps and flats, and will try to optimize the melodic 
enharmonic spelling to avoid augmented or diminished intervals. There are no options yet, 
but it will be enhanced to allow for various spelling philosophies. 

 

Accidentals 
This command is used to add accidentals according to various options. It is aimed mainly 
at 20th century music where almost all notes have accidentals. 

 

Fill With Rests 
Use this feature to fill measures with rests according to the time signature. Each beat will 
have its own rest, in the same way Finale’s Time Signature dialog displays notes 
symbolizing the beats. 

 

Create Hairpins 
This plug-in will mass-create hairpins based on existing dynamic markings. Both measure 
and note-attached text expressions are interpreted. The plug-in automatically detects the 
necessary direction of the hairpin! However, it will not create a hairpin between one note-
attached and one measure-attached expression. 

A problem here is the distance from the dynamic markings that the hairpin should have. It 
needs to be specified in EDUs, where 1024 equals one quarter note (crotchet). However, it 
is sometimes necessary to compromise when mass-creating hairpins because a quarter 
note does not always take up the same amount of space, so that any given value entered 
here will effectively result in varying actual distances. 

If you want to confine the hairpins to be between specific kinds of dynamic markings only, 
you can specify, for example, that the ‘left marking must be: fff’. Enter normal letters here 
to specify the dynamic, such as: fff, p, pp, fp, sfz. 

 

Create Slurs 
This plug-in can mass-create slurs, as long as you want them to be over the same number 
of notes for each slur. Also, it will not create slurs across barlines. You can either choose 
to use the standard slur positioning and/or contour settings, or you can override them – for 
example, in order to leave room for articulations. 
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Laisser Vibrer 
Using the Exgraver Font Set as music font, this plug-in can automatically choose the 
correct laisser vibrer noteheads: 

 

 

Combine Rhythms and Pitches 
This plug-in copies pitches from one staff to another staff which contributes the rhythm. 
Thus, the result of the combination is always put into the former rhythm staff. 

 

becomes: 
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Smart Split Point 
(preview – available only in versions 1.904 and above) 

This plug-in operates on piano music where some notes have been put into the wrong 
staff, for example, by Hyperscribe. It tries to guess which notes need to be moved and 
does this all-automatically. Some options can be set to customize the behavior. 

 

Example 

 

becomes 

 

Option Settings 
To obtain the best possible results, you may have to make one or two changes to the 
option settings. They are described here: 
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♦ Max. simultaneous interval in upper staff (8=octave): this option should be set 
according to the music being processed. Specifying the maximum interval that can be 
found in the correctly notated music will produce better results. 

♦ Max. simultaneous interval in lower staff: same as previous option, but for the lower 
staff. 

♦ Max. leap in upper/lower staff: this information can also help the plug-in to make the 
correct educated guesses in terms of which notes should be moved. 

♦ Minimize simultaneous intervals per staff: this option will move notes even though 
the maximum interval in a staff is not exceeded. You can uncheck it if it produces 
incorrect results. 

♦ Minimum notes in bottom staff: if you would like to ensure, for example, that no rests 
remain in the lower staff, you can make use of this option and specify the minimum 
number of simultaneous notes in the bottom staff. 

♦ Try to remove resulting rests by expanding the preceding note values, 
Allow moved notes replacing rests to be longer than before, 
Allow notes added to chords to be longer than before: 
These options will help making the output of the plug-in clearer. Uncheck any one of 
them if they produce incorrect results. 
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Make parenthesized trill notes 
This plug-in introduces a new method of entering trill notes. The notes to trill with will 
appear as small parenthesized notes directly following the main note. 

First, these notes are entered as grace notes preceding the main note. Then, the plug-in 
is invoked: 

 

 

becomes: 

 

Advantages: 

♦ the trill note can be transposed and will transpose automatically in extracted parts 

♦ the trill note can have quarter tone accidentals or any other special treatment available 
for normal notes 

♦ the trill note will always stick close to the main note – even if the measure is ex-
panded or contracted on the page layout. 

Drawbacks: 

♦ Finale's Note Spacing naturally allocates space for grace note at the original position, 
and not at its intended position. In scores, however, this is rarely a problem since trilled 
notes are mostly longer notes so that there is enough room for the trill note. 

♦ Note Spacing, if applied after using this plug-in, will restore the original grace note 
positions. When this occurs, use the Repair trill notes (after Spacing) command 
described below. 

In most cases, the advantages outweigh the drawback by far. Also, I'm planning to extend 
Finale's Note Spacing so as to handle these trill notes properly. 

 

Options 
 

 

♦ Duration of grace notes to be modified: you can use any grace note duration to 
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create trill notes. Recommended is using fourth or eighth notes.  

For trill notes within or after beam groups, use an eighth grace note for the trill note 
so that the beam is not interrupted. Enter an 8 into this option field. 

♦ ID number of empty shape to replace note stem and flags: to remove the grace 
note's stem and flag, Finale's Custom Stem special tool is used. By using a non-
existant shape ID such as 1000, the stem and flag become invisible. 

♦ Horizontal note shift: this is the EVPU shift that moves the grace note from the left to 
the right of the main note. May have to be adjusted depending on your music font. 

♦ Additional horizontal shift with dotted notes: when the main note is a dotted note, 
the trill note has to be shifted a bit more, as specified in this option. 

♦ The Parentheses... button will show an additional dialog with options on how the 
parentheses are applied to the grace note. See Parentheses on page 23. 

 

 

 

 

Repair trill notes (after Spacing) 
This simple command is used when Note Spacing has reset the trill notes to their original 
grace note position. 

There are no options since the options are taken from Make parenthesized trill notes. 

 

 

 

 

 

Parentheses 
Parenthesized notes are used by Harmonics Automation and Make parenthesized trill 
notes. 

Parentheses are added as text expressions. A new text expression is created only if the 
required expression does not already exist. 

Some of the options in this dialog may have to be adjusted for different music fonts or 
grace note size percentages. 

For options, see the next page. 
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♦ Accidental shift: to save space, accidentals on parenthesized notes can be shifted to 
the right. Enter the EVPU amount or modify the default value if needed. 

♦ Font for parentheses: you can enter your preferred font used for the parentheses text 
expressions. On Windows, this defaults to Times New Roman, and on the Macintosh, it 
is Times. 

♦ Font size: this is the size used for the parentheses text expressions. It may have to be 
adjusted, too. 

♦ Parentheses for notes with/without accidental: these two fields contain the actual 
text that is used to create a pair of parentheses with enough space in between to 
contain the note with or without accidental, respectively. 

♦ Horizontal parentheses displacement for note with/without accidental: These two 
fields contain the horizontal offsets to the note. They're negative, since the parentheses 
start to the left of the note. 

♦ Vertical parentheses displacement: this value is also negative, since the paren-
theses' origin is below (and left to) the note. 
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Chapter Three 
 

Spacing Utilities 
 

Make or Remove space at end of measure 

Add or Remove space in measure 

Expand or Compress Spacing 

Measure Widths 

Modify a measure's leading white-space 

Remove extraneous beat chart elements 

Proportionality 
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Spacing Utilities 
These commands work on the spacing of notes within a measure. Finale's spacing data is 
contained in beat charts. Thus, all that these utilities do is to modify the beat chart and the 
measure's length. 

You can use these utilities without caring about beat charts at all. However, to fully 
understand their function it may be helpful to check out the beat charts yourself – you can 
access them from Finale's Measure Attributes tool. Click the second of the two or three 
handles that appear at the top of any barlines. 

Not all measures have these beat charts. Usually, apply Note Spacing from Finale's 
MassEdit menu to create an individual beat chart for each measure. See the following 
page for a screenshot of a measure along with its beat chart. 

Note: Most of the spacing utilities work with measures that have been note-spaced only. 
You can try them out with beat-spaced measures also, but they may or may not 
have any effect on such measures. 

The Spacing Utilities usually work on all measures within the selected region, whether they 
have been selected partially or completely. Only the tool Expand/Compress Spacing has 
been designed especially for partial measure selections. 

The exact internal proceedings of how the beat chart data is interpreted for displaying and 
printing a measure are one of Coda's well-kept secrets. I have found out, say, 95% of it, 
and thus my Spacing Utilities work well and act as desired in the vast majority of cases. 

However, there may sometimes be minute side-effects on the part of a measure which 
wasn't supposed to be changed. In most cases, this will not disturb you. I'm working on 
reducing these side-effects as much as possible. 
 

Overview 
Make or Remove space at end of measure by compressing or expanding the measure's spacing 

Add or Remove space in measure leaving the existing spacing untouched. 
The added space can be inserted at the beginning or the end of the measure. 

Expand or Compress Spacing – mostly used for partial measures.  
This will widen or tighten whatever you selected with the mass mover tool. 

Measure Widths – sets the widths for multimeasure rests, empty measures, and measures containing 
only one entry. 

Modify a measure's leading white-space is used to set or limit the space between a measure's 
barline and its first note.  

Remove extraneous beat chart elements can tidy up your beat charts. It leaves only those 
handles in the beat chart that are actually required to achieve the correct spacing. This can be helpful for 
subsequent manual tweaking. 

Proportionality (after Note Spacing) 
This command will try to improve the proportionality of a measure's spacing. Use it after Note Spacing has 
distorted the measure's proportions. 
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Make or Remove space at end of measure 
by compressing or expanding the measure's spacing 

This command will not change the width of a measure, but it will widen or tighten the 
measure's spacing – so that space is added or removed at the end of the measure: 

 

 

 

 

 

will be changed to: 

 

 

Options 
There is only one option to set: 

To make free space, compress measure by %: 

Here, you specify the percentage of free space that will be freed at the end of the 
measure. If a negative percentage is specified, the spacing will be expanded – it can even 
be made to extend beyond the measure's right barline. 
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Add or Remove space in measure 
Sometimes, you need more space within a measure so that you have room for beat chart 
modifications. Or, you want to get rid of superfluous space. That's what this command is 
for – it adds or removes space to or from the measure. It can do so either at the end or the 
beginning of the measure. 

 

Example 

 

after adding some space: 

 

 

As you see, the new space has been added mainly to the end of the measure. However, a 
slight widening of the music can also occur. I’m trying to optimize this in future versions, 
even though it already does a good job in most cases. 

Options 

 

♦ specify the EVPU amount of free space to add or remove 

♦ check whether to add the space at the beginning of the measure. If unchecked, it will 
be added at the end. 

♦ Undo / Redo will trigger Finale’s undo and redo commands from the Edit menu. 
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Expand / Compress Spacing 
Another feature that’s missing from Finale’s beat chart editor is the ability to expand or 
compress partial measures. Very often, a few notes should be spaced a little narrower, or 
sometimes, a little wider. 

No matter how many notes you want to widen or tighten horizontally, this is the command 
that can do it. Select any part of a measure - although you can select multiple measures, 
too, whether they  include partial selections or not. 

On Windows, expand and compress can also be triggered via Shift-Gray + and -, 
respectively – without showing a dialog box. (The Gray keys are on the numeric keypad.) 

On the Mac, we have no shortcuts yet – but you could use a macro program for it. I do 
intend to program shortcuts for the Mac, too. 

Example 
On the left, you see Finale’s default spacing. On the right, the four 16th notes have been 
made tigher using Compress Spacing with the fourth beat selected. 

 

 

becomes: 

 

This example shows that the change has affected almost only the fourth beat which had 
been selected. However, as a side-effect, the distance beween the 3rd and 4th beat has 
been increased. Which, in this case, has even been quite desirable  ☺ . 

Options 

 

♦ Expand spacing by: EVPU amount for the expansion or compression of the selected 
region. Use a negative number to achieve the opposite of the dialog box’s title. 

♦ Include space between notes and barlines? Usually, this option is off because the 
space between notes and barlines should be kept constant. 
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Measure Widths 
This command sets the width for special kinds of measures: 

• multimeasure rests 

• empty measures 

• measures with only one entry (note or rest); i. e. measures that are filled with one 
note or rest equal to the measure’s total rhythmic duration 

Also, the width of the width of the two latter kinds of measures can be dependent on their 
rhythmic duration, and a scaling factor is used to determine how this is done: 

• 0% produces measures of equal length, 

• 50% will set a 2/4 measure to ¾ of the specified length (which is for 4/4 measures). 

• 100% will set a  2/4 measure to half the normal length. 

 

Modify a measure's leading white-space 
Sometimes, Finale's spacing seems to allocate superfluous white-space at the beginning 
of measures. Or, you want to set the initial white-space of a region of measures to a 
specific amount. Note that since this change is applied to the beat chart, it affects all 
instruments within a score no matter how many staves were selected. 

Example 

 

 

 

 

becomes: 

 

The plug-in tries to move the first beat chart handle to the left without modifying the 
remaining part of the measure. In this case, a side-effect was a slight widening of the rest 
of the measure. 

A future revision will have less of a side-effect and will include an option to move the whole 
measure to the left, not just the first beat chart handle. That way, the measure could 
actually be shortened. 

Options 
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♦ Limit a measure's initial while-space to: EVPU value of the maximum white-space to 
allow. Note that Finale also stores Minimum Position values in the beat chart, which 
may result in more white-space even though this option has been set to a 
comparatively low value - see the last option. 

♦ Always set to this value: if checked, all measures will receive this value as their initial 
white-space. If unchecked, only the measures with more initial whitespace will be 
modified. 

♦ Subtract from initial white-space: a value entered here will be subtracted from a 
measure's initial white-space. This can be used to take away some initial space if you 
don't want to set all selected measures to the same value. 

Maximum 'Minimum Position' to allow: to avoid collisions, Finale stores a 'Minimum 
Position' value in addition to the position of each beat chart handle. Since this 'Minimum 
Position' may be responsible for wasted initial white-space, it is good to specify a limit here 
which should be a little higher than the value specified in the first option field – or just leave 
the default setting as it is. 

 

Remove extraneous beat chart elements 
Through Finale's note spacing, each rhythmical position on which there is a note will get its 
beat chart handle. Some of these handle are required - to achieve the desired spacing and 
to avoid collisions. Others may be extraneous with regards to spacing – 'their' notes would 
be positioned in the same horizontal location even if these beat chart handles were de-
leted. 

Sometimes, it is desirable not to have so many handles in the beat chart. For example, 
with only one handle starting a group of 16th notes, it is easy to widen or tighten them 
using the beat chart editor. 
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Example 
 
 

 
becomes:

If you find that you need more handles than this plug-in will leave you with, you'll have to 
double click within the beat chart to insert a handle. Unfortunately, this is currently only 
possible on regular metric positions – 16th or 32nd notes positions are possible, but exact 
positions of notes within tuplets cannot be created. 

Options 
The only option to set is the maximum deviation (per thousand). The default value of 50 
(=5%) would allow for slight changes in the spacing produced by removing beat chart 
handles. If you require the spacing not to be altered at all by this process, you can go 
down to 1% which should result only in invisible differences. 

 

 

Proportionality 
Restore proportionality in horizontal spacing after Finale’s Note Spacing has been applied. 

Depending on the allotment library used, Finale may make a measure’s spacing quite 
disproportional – the opposite of Time Signature Spacing. This command is intended to 
restore a desirable percentage of proportionality. 

Example 

 

is improved to: 

In the upper screenshot, the distances between the notes are almost completely indepen-
dant of their duration. After applying the Proportionality tool, the quarter notes and the 
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dotted quarter note have received their appropriate space.  

This could not have been easily achieved with an allotment library since the lyrics make 
the eighth notes very wide. Thus, an allotment library normally wouldn't assign enough 
space to the quarter notes. 

If the result seems to widely spaced, the measure can easily be made tighter using 
Finale’s Measure Attributes tool. 
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Options 

 

♦ Minimum proportionality factor in percent: using this setting, you can specify how 
proportional the spacing should be. 100% delivers a similar result to Time Signature 
Spacing, while the default value of 70% leaves a reasonable amount of flexibility. 

♦ Clear Minimum Positions: this option is normally off. Use it when you want to make a 
measure’s spacing quite tight while maintaining proportionality, and when the other 
options don’t result in the required density. Rarely used. 

♦ Make notes as tight as possible: this option is the first to try when you want a tighter 
spacing. The tool will ignore any of Finale’s spacing that goes beyond avoidance of 
collisions. 

♦ Try to reduce Minimum Positions if appropriate: another option for making the 
spacing tighter – can especially be used in conjunction with the preceding option. This 
option can remove superfluous space allocated to ledger lines or measures with 
accidentals. 

♦ Maximum EVPUs of whitespace to add: this is the maximum space to be inserted 
between two notes. You may want to reduce this limit. 

♦ Maximum whitespace increase in percent: the maximum percentage by which two 
notes‘ distance may be increased. 
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Staff List Manager 
This is a power tool for scores that work with optimized staff systems, i. e. scores where 
not all instruments appear on all pages, or where staff distances vary. Finale already 
provides a mechanism to create optimized systems, to remove optimization, and to 
remove single staves from a page. TGTools Staff List Manager adds the following 
capabilities: 

♦ Paging through the score with an overview of the staves in each system, and asterisks 
next to all instruments that have notes within the system's measures, 

♦ Re-including or adding instruments without having to start over with the optimization, 

♦ Fine-tuning staff distances using the EVPU column on the left. 

♦ One-click optimizing of a staff system, 

♦ One-click resetting of a staff system to the non-optimized version while retaining the 
added features of optimized staff systems, 

♦ Check for optimization errors. 
 

Screen shot 

 
 

Description 
The main part of the dialog box is the selection list in which you see the names of all 
staves. When a staff is checked, it is included in the system that's currently displayed. 
Staves with an asterisk have notes within the measure range of that system. 

Groups are displayed to the right of the staff names: at the beginning of a staff group, you 
see the group name or a backslash \ if there is no group name. If the group is longer than 
two instruments, a vertical line|continues it downward. A slash / marks the end of a 
group. 

On the left, you will find the EVPU positions of the staves. By default, the checkbox 
‘relative’ is checked so that these figures represent the distances from each staff to the 
preceding one. When ‘relative’ is unchecked, you’ll see the absolute positions from the top 
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of the system. 

Checking and unchecking instruments is quite flexible – staff positions and group 
assignments are automatically handled for each system. Note that there is a minimum 
distance to avoid collisions of staves which may not currently be suitable for working with 
single-line staves. Also, hidden staves are shown as normal staves and may result in staff 
collisions when the staff list is modified. 

Paging through the score 
There are three fields which assist you in finding the right position within the score: page, 
system, and measure number. 

Warning: Staff List Manager currently does not take into account your current position 
within Finale, nor any selection of measures. Please be careful to go to the correct staff 
system before applying any modifications. 

Whenever the information needed for page or measure specification is not available from 
Finale, you will see a question mark in those fields. Using Finale's Update Layout 
command may help to provide more information here. By default, Update Layout is 
invoked automatically (can be disabled in TGTools Options). 

Powerful button commands 
♦ Redraw: makes Finale show the current system (if you’re in page view), and you can 

immediately verify the changes made. 

♦ Revert: undo changes to the currently displayed system and reload the system's data. 

♦ Optimize: optimize the system so that all staves with asterisks are checked. 

♦ Reset: makes the system appear exactly as in scroll view. However, the system has all 
advantages of an optimized staff system – only no optimizations have been applied yet. 

♦ Scale... activates TGTools Scale Staff Positions which can make several staff systems 
have the same total height. 

♦ Copy from... and Copy to... activate TGTools' Copy System Optimization with which 
you can copy the staff list with all positioning from another system or to other systems.  

♦ Find Optimization Errors: scans all systems starting with the currently displayed 
system for staves that have notes but are not displayed within the system. 

♦ OK: dismisses Staff List Manager and saves all changes made. 

♦ Cancel: dismisses Staff List Manager and cancels any changes made to the currently 
displayed system. Changes made to other systems were saved when you paged 
through the score and cannot be canceled (use Finale's undo feature instead).  
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Join Two Staff Systems 
Used to combine the measures of two systems (in page view) into one system. This plug-
in will ensure that the measure layout of the remaining piece remains intact, as well as the 
system optimizations. 

You need this command only if you want to make adjustments to the measure layout that 
involve a change in the number of systems. 

 

Split Staff System 
This is the opposite of the previous command. It will split a staff system into two or more 
systems. 

When the measure layout gets too tight, you can use this plug-in to insert a new staff 
system while preserving layout and optimization in the rest of the piece. After the split, you 
can shuffle measures around as needed. 

 

Before Deleting Measures 
This command will enable you to preserve measure layout and system optimization when 
deleting measures from within a piece. You need to select the measures to be deleted, 
invoke this plug-in, and finally perform the deletion using the Delete key or the Measure 
Tool’s Delete command. 

This command is not needed for Finale 2001 and above! 

 

After Inserting Measures 
This command works similarly to the previous one. After inserting measures, leave the first 
of these measures selected and invoke the plug-in. It will distribute the new measures on 
the number of systems that you want, while preserving the measure layout and system 
optimization in the rest of the piece. The command should also be used after inserting 
music via Edit->Copy and Edit->Insert. 

This command is not needed for Finale 2001 and above! 

 

Fit Measures 
This plug-in will fit a specified measure region into a desired number of systems. Currently, 
it cannot fit them into more systems than before. It will try to distribute the measures as 
evenly as possible throughout the available systems. It can handle multi-measure rests 
automatically. 

In order to be able to save space with empty measures, especially when laying out parts, 
this plug-in can automatically invoke the Measure Widths plug-in. This is also used in 
order to be able to make multimeasure rests shorter. 

Normally, the resulting systems should be locked, so this is the default option setting. If 
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you should ever need to avoid locked systems, you need to be aware that the result of this 
plug-in may not have a chance to become visible, since Finale’s Update Layout may 
immediately reflow all measures (see Finale’s Update Layout options). 

After fitting the measures, this plug-in invokes the Update Layout command. This cannot 
be turned off since it is an absolute necessity. 

Update Groups 
When modifying groups and brackets in scroll view, these changes will only be made for 
staff systems that have not been optimized. Use this plug-in to update optimized systems 
so that they have the same groups as in scroll view. Select the groups to be updated, or 
make no selection in order to update all groups: 

  

" Identify using full group name: it is important to understand that the plug-in needs 
a way to match the existing groups in the optimized staff systems with the scroll 
view groups. With this option on, the full group name must be identical for the group 
to be identified. If the full group name has changed and needs to be updated, this 
option must be turned off. When the option is off, other attributes are used for 
identification – most importantly the instruments included in the groups. However, 
this option should be on whenever possible because it makes identification more 
reliable. 

" Update group names: if checked, group names will be updated if they aren’t 
identical. If the full group name has changed and needs to be updated, turn off the 
previous option.  

" Update instruments within groups: if checked, group instrument ranges will be 
updated. For this to work well, the dialog’s first option should be on. 

Groups cannot be removed yet – this feature will be included in a future version. 
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Incipits 
In certain cases you will want the measures to have exactly the same width on the page 
that they have in scroll view. For example, in order to make a table of contents showing 
the beginnings (incipits) of several pieces: 

 

The Incipits plug-in will set the margins for staff systems in page view in such a way that 
most closely resembles scroll view in terms of measure widths. Just select the measures 
to affect and invoke the menu item ‘Incipits’. 

 

Scale Staff Positions 
This plug-in is used for optimized staff systems only. It will expand or compress the vertical 
spacing of staves so that each system has the same total height. Alternatively, it can try to 
match two optimized systems on facing pages so that each instrument ‘flows’ from the left 
page into the right page at the exact same vertical position. Blank space is inserted into 
both pages to leave room for instruments that are used on the repective other page. 

 

Regular Scaling 
Through scaling the staff positions, systems with a differing number of staves can maintain 
a uniform total height, which is sometimes desired in scores. This function is in effect when 
“Align systems on facing pages” is not selected (the default). Only the following options are 
used (please ignore the staff selection list which is visible on Mac): 

 

 

♦ Desired position of bottom staff (EVPUs): To specify the desired height of the 
system, the bottom staffs EVPU distance from the top of the system is used. 
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This EVPU value has to be obtained from a system in the score that already has the 
desired height. This should be done using Staff List Manager, with the option “relative” 
unchecked so that absolute EVPU positions are displayed. 

♦ From / To system: specify the range of staff systems (not pages) to be scaled to a 
uniform height.  

♦ Expand spacing: with this option checked, shorter systems will be expanded to the 
specified EVPU height (the default). 

♦ Compress spacing: with this option checked, taller systems will be compressed to the 
specified EVPU height. This may result in collisions. 

 

Aligning systems on facing pages 
This option is intended for scores with one system per page. To align each staff within 
systems on facing pages so that each staff is printed at the same vertical position on both 
the left and right page, use this sub-function of the Plug-In. The following options are used 
from the dialog, including the staff selection list – in case you don’t want to align all staves: 

 

• First page is even: This needs to be set if the first page is a left page (i.e. it has an 
even page number). Uneven document page numbers such as 1,3,5 etc. are then 
considered left pages. This is OFF by default, so that page number 1 is not adjusted 
because it has no facing page. 
checked: facing pages are numbers 1 & 2, 3 & 4 etc. 
unchecked: facing pages are numbers 2 & 3, 4 & 5 etc. 

• Move all subsequent staves down to avoid collisions: Checked by default, this is 
the strict alignment mode. Instruments that occur on one of the facing pages only will 
always result in whitespace on the other page. If the instruments shown on the two 
facing pages are very different, this can result in systems that are too high. In that 
case, try unchecking this option to save some space. Unchecked, the option will allow 
two different instruments to be in the same vertical position if both are shown on one of 
the two facing pages only. 
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Shift System Optimization 
This command will shift the staff configuration, groups, and positioning left or right within 
the sequence of staff systems. You may need this to resync the systems with the correct 
measures after adjustments to the measure layout. 

Note that if you use Before Deleting Measures, After Inserting Measures, Split Staff 
System, and Join Two Staff Systems, then the layout should never become out-of-sync. 

 

Copy System Optimization 
This command will copy staves, groups, and positioning from one optimized system to 
another or many other systems. 

This can be a very powerful utility, since it can automatically select only those systems as 
destinations that have the same set of staves (instruments). Thus, within a larger score, 
you could adjust all pages or systems where a certain instrumentation is used – make the 
adjustments on one page, and copy its optimization to all others. 

On the other hand, you can also copy the optimizations to systems that have not been 
optimized yet. This is currently a little dangerous because there may be notes in 
instruments that are hidden by this command. 

Options 
♦ Copy system optimization FROM system no: specify the source system – the one 

whose optimization is to be copied to other systems. 

♦ TO system range – first / last: specify the destination system range. If you want only 
one system as destination, specify, for example, 5 to 5. 

♦ Copy to systems containing the same set of staves only: (default: checked) 
This option ensures that the optimization is copied only to systems with the same 
instruments. To be safe, this should be checked. If the source system is optimized 
correctly, no staves with notes on other systems can unintentionally be hidden. 

♦ Copy to systems that have not been optimized: (default: not checked) 
This will use the optimization of the source system for any unoptimized systems within 
the specified range. If the source system does not contain all of the document's staves, 
this can be dangerous because staves with notes could be hidden. 

 

Note: To copy the optimization unconditionally to all destination systems, check the 
second option only. This may hide notes. 
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Playback 
_______________________ 
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_______________________ 
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_______________________ 
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TGTools v1.88   

44 

Modify-Align/Move 
This plug-in will (vertically) align dynamics, including staff and score expressions, and 
hairpins. Hairpins will in fact be straightened since begin and end point are both vertically 
aligned. 

Other features: 

• automatically enables individual positioning of score expressions so as to make 
independent alignment in each staff system possible 

• moves other expressions along with the dynamics, but does not align them: note 
the word "subito" and "poco" in the example below. 

• especially useful with transposed parts 

 

will be aligned to: 

 

Hotkeys 
• select a region, then press Alt-Gray Plus and Minus to align and move dynamic 

marks up and down, with hairpins. 

• press Alt-Gray Multiply to align only. 

• The Gray keys are on the numeric keypad. On the Mac, use the Cmd or Apple key 
instead of Alt. 

 

Transposed score vs. concert pitch 
When hairpins don’t seem to be aligned with note-attached expressions, it may be 
because TGTools don’t know whether the music is transposed or in concert pitch. When 
turning the score's display in concert pitch on and off, the plug-in cannot immediately 
recognize this. The same applies to switching between files that differ in this respect. 

To make the change detectable to TGTools, please enter the Options menu once more 
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(without selecting any item) after having changed this option or loaded a file. 

Options 

 

• Align: select how the desired vertical position should be calculated. You can align 
to the element that's nearest or farthest to the staff, or align to the average distance 
of the objects within the selected region. Also, you can chose to set a specific 
distance, ‘set to value on the right (side of the dialog box)’ 

• Text Expressions: checked by default, this will include text expressions in the 
objects to align. 

• Hairpins: select whether you want them to be affected. 

• Note-attached Lines: these are smart shapes created with the tab slide or custom 
line tool. 

• Shape expressions: select this to have them aligned with the text expressions and 
hairpins 

• Move vertically: enter a vertical offset by which the aligned objects are shifted.  

 

More Options 
• Align what's below the staff: normally selected because dynamics go below the 

staff 

• Align what's above the staff: select this to align objects above the staff. If you 
want to align non-dynamic markings, you have to also deselect an option further 
down (Align only ‘dynamical’ text expressions). 

• Align above/below separately: if you’re aligning objects both above and below the 
staff lines, you can either align the two areas independently, or move them all to the 
same vertical position. 

 

• For positioning, consider: when items are aligned, there are various possible 
ways to determine the desired vertical position. The basic strategy is specified in 
the main dialog (furthest/nearest/avarage/specific position). In addition, you can 
specify here which kinds of items should be taken into account at all in the 
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positioning strategy. These needn’t be the same items that are affected by the 
alignment. 

See ‘repairing transposed parts’ for an example. 

 

• Adjust other expressions appropriately: normally selected so that expressions 
that go with the dynamics are moved also - but not aligned. For example, when a 
hairpin with the text "poco" is moved, the word is moved with it, but not on it. 
See the example above. 

• Avoid collisions with staff lines: will prevent dynamics from being moved up too 
far. You may need to deselect this for one-line staves. 

• Align each system independently: when a larger region or a whole document is 
aligned, each staff system can be processed separately since the alignment is 
normally only needed within a system. 

Note: this option is turned off when the hotkeys are used for invocation. 

• Restart alignment after how many measures without dynamics: this option tries 
to divide the selected measure region into several sub-regions, which are aligned 
independently. For example, when aligning dynamics to the farthest element, this 
can cause them to be positioned very far away from the staff – possibly just 
because of the original position of one of the markings. To prevent that the whole 
document’s dynamics is positioned so far away from the staff, this position will not 
be applied after some measures without dynamics. 

• Additional music fonts to align: if you have dynmic markings that this plug-in 
doesn’t recognize as such and which it doesn’t align, then you may have to enter 
the music font used for these into this field. 

• Align only ‘dynamical’ text expressions: this option makes sure that only the 
desired objects which deal with dynamics are aligned and/or moved.  This should 
normally be left on - unless you discover that not all the text expressions that you 
want aligned are actually processed. 

• Vertical hairpin adjustment: here, you can adjust the positioning of hairpins in 
relation to other objects, such as text expressions. 
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Repairing transposed parts 

 

is repaired to: 

 

 

There's two possible things you may want to do in this case: 

1.  Move hairpins to align with expressions (as in the example) 
turn off "For positioning, take into account: Hairpins?" 
turn off "Adjust other expressions appropriately" 
otherwise stick to the defaults 

or 

2.  Move expressions to align with hairpins 
turn off "For positioning, take into account: Staff expressions?" 
otherwise stick to the defaults 
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Modify-Playback 
Some musical items don't automatically play back in Finale. TGTools->Modify->Playback 
can prepare the following items for playback:  

• note-attached glissandi (via pitch-bend or fingered)  

• hairpins  

• trills (requires articulation or smart shape trill: )  

• articulation tremolos and percussion diddles 

• Make sure you read the comment on Playback Notes on this page. They need to 
be hidden ...  

Glissandi  

• Whereever possible, glissandi should be note-attached. Use measure-attached 
glissandi if the glissando goes into a different direction from the following note.  

• After you've created them all, run the plug-in. Choose whether they are to be 
fingered glissandi, or (if unchecked), they are pitch-bended glissandi.  

Pitch-bended glissandi 
• The plug-in adds pitch bends as continuous data. To see the results, use Finale's 

MIDI Tool, and set it to display continous data (Pitch Wheel).  
• For the glissandi to play back correctly, the synthesizer's or sound card's bender 

range needs to be set. With the default options, the plug-in will add the required 
MIDI events automatically. Since this is necessary only once per staff in a file, you 
can turn the option off for the second and following glissandi. The bender range is 
normally 12 so that each glissando's maximum range is one octave.  

• To remove pitch-bend playback data and undo the effect of this plug-in, use the 
Mass Mover tool's menu command Clear Items->Only Selected Items->Measure 
Items->Continuous Data.  

Fingered glissandi 
• For playing back fingered glissandi, the plug-in adds playback notes to another 

layer. These notes are visible by default, and it's currently up to you to hide them. 
They cannot be hidden individually using the speedy entry command because then 
they're not played back. Make sure the option to 'individually hide playback notes' is 
off (it's in the More... dialog).  

• Playback notes can be hidden in one of several ways:  
o Finale 97/98: Apply Alternate Notation/Invisible Notation  
o Finale 2000+: Apply a Staff Style with invisible layer  
o or, in any version of Finale, if you only want to see notes in layer one in the 

whole document, select "Show active layer only" from the View menu. Note 
that this option applies to printing as well.  

• You should uncheck some of Finale's Layer Options so that the playback notes 
don't affect your music's stem directions and rest placement.  
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Hairpins  

• This plug-in makes smart shape hairpins play back regardless of any text 
expressions. In other words, dynamic markings other than hairpins do not play a 
role for this plug-in.  

• Hairpins will play back thru MIDI volume changes, while dynamic markings usually 
affect key velocity. When the file is played, both these layers work together to form 
the actual loudness of a tone.  

• After you've created the hairpins, run the plug-in.  

Volume Changes 
• The plug-in adds gradual volume changes as continuous data. To see the results, 

use Finale's MIDI Tool, and set it to display continous data (controller no. 7 / 
volume).  

• To remove volume changes and undo the effect of this plug-in, use the Mass 
Mover tool's menu command Clear Items->Only Selected Items->Measure Items-
>Continuous Data.  

Notes 
• The plug-in tries to guess the optimal volume change values automatically. The 

underlying principle is this: a crescendo from p to f will usually result in the volume 
going from 64 to 127. But, the final note that has the f attached is set back to a 
volume of 64 because it's strengthis given by the key velocity that is programmed in 
the f expression. It doesn't need a volume of 127 in order to sound loud. 
When, after this crescendo, another crescendo starts, say, from f to ff, the volume 
changes will again go from 64 to 127.  

• This strategy might not always give optimum results since the interaction of volume 
and key velocity is a complex one. Let me know if you have a file where it doesn't.  

 

Trills, Tremolos, Percussion Diddles  

• Trills require smart shape trill symbols above the notes: , or a tr articulation.  

• Set these options before applying the plug-in:  

o are three-slash tremolos unmeasured (like trills)?  

o Trill speed (trill notes per quarter note - only for unmeasured tremolos and 
trills)  

o Start trill after what percentage of duration - only for unmeasured 
tremolos and trills: 
(set to zero if you want the trill to start immediately)  

o Start trill with upper note? - only for trills  

o Force trill interval (semitones) - only for trills 
If this field is empty, a diatonical trill will be made. If you want to force a
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semitone trill, enter the number 1 here. It supports trills with lower notes (-1, -
2 etc.), as well as repetitions (interval 0).  

Playback notes 
• For playing back trills and tremolos, the plug-in adds playback notes to another 

layer. Since Finale 2002, these notes are hidden automatically.  
• In previous versions, they can be hidden in one of several ways:  

o Finale 97/98: Apply Alternate Notation/Invisible Notation  
o Finale 2000+: Apply a Staff Style with invisible layer  
o or, in any version of Finale, if you only want to see notes in layer one in the 

whole document, select "Show active layer only" from the View menu. Note 
that this option applies to printing as well.  

• You should uncheck some of Finale's Layer Options so that the playback notes 
don't affect your music's stem directions and rest placement.  
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Modify-Remove 
Sometimes it is desirable to remove certain items or properties from a selected region, 
without removing any notes or text. In fact, it is possible to remove only one specific 
characteristic and leave all other properties and items alone. If you're not removing 
concrete visible items, you're removing properties or adjustments in order to reset them to 
their default states. 

Options 
This command opens the Remove dialog box which provides some options that are not 
available in Finale's MassEdit ⇒ Erase... command. It works similar to Finale’s command, 
but it offers different things to remove from the selected document region. 

All the 'items' offered here are properties – when you remove them, they will be reset to 
their default appearance. In addition, it can convert notes to rests and remove stems 
and beams. It can also remove hidden rests, which can be used to clean up SmartScore 
files. 

For Convert notes to rests, you will find two additional options: left/right percentage. 
100 means all notes are converted. Lesser percentages determine the likelihood at which 
notes are randomly removed. Separate options for the left and right ends of the selected 
measure region enable you to program a development from one state into another. 
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Modify-Reset 
This plug-in can reset the following smart shape properties to their defaults: 

" note-attached slurs’ positioning can be reset to match Finale’s default 
positioning. This will not result in any slurs being flipped. 

" select ‘make horizontal over system break’ for hairpins 
This is useful, because by default broken hairpins become diagonal if one half is 
dragged vertically (in page view). 

" repair smart shape / measure expression bits: try this when you feel there 
should be either of these items in your measures but they’re not visible. 

 

Modify-Special Modifications 
This is a generic plug-in where you can select between several search criteria and 
combine these with certain actions that you want to be performed on the notes that match 
the criteria. 

For example, you can perform these tasks: 

• look for all C4’s and remove them 

• look for every chord’s second note from top, and change its notehead size to 70% 

• look for rests, and hide them 

• look for notes with sharps (=alteration 1) and erase them 

For playback of complex quarter tone scores, this last option can be used in order to 
create two different files from the main score; one with all the ‘straight’ notes, and another 
one with all the quarter tone pitches. These could be fed into two separate synthesizer 
channels for playback. To do this, you need to remove all even alterations from one file  
(-2, 0, 2) and all uneven alterations from the other copy (-3,-1,1,3). 

 

Modify-Rests 
• will provide for ‘classical’ rests in 3/8, 3/4, and 3/2 time signatures by splitting rests 

up 

• can minimize the number of rests by expanding preceding note values 

 

Modify-Replace Pitches 
allows you to replace pitches in specific octaves. Examples: 

• change D#4 into D4, 

• and D##5 into Dbb5 

• and B4 into B6. 
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Modify-Expressions 
This plug-in allows you to make certain manipulations with expressions. Some of this were 
formerly impossible to do at all. 

The main function is to convert measure-attached expressions into per-staff ones: this 
will make an individual copy of the expression for each staff that it appears on. The 
conversion will enable you to copy music along with the expressions within a file. 

Additional options are available: 

• Leave these on one staff only: this will change a measure-attached expression so 
that it appears on the selected staff only. 

• Make them note-attached: this will convert measure-attached expressions into 
note-attached ones. It works with measures with notes only. Slight horizontal 
inexactness is possible. 

• Align with nearest note: this option is used when making expressions note-
attached. You can have the horizontal position changed by aligning the expression 
with the nearest note, and specify a horizontal offset from the note that the 
expression should have. 

 

A completely separate feature is the multiplication of horizontal positions of measure 
expressions. This does not work together with the conversion described above. It is a 
very rarely used feature. 

 

Modify-Slurs 
This plug-in can perform the following modifications on slurs: 

• convert measure-attached slurs to note-attached ones 

• Recalculate note-attached slurs’ contour to match the current contour settings. 
This can be useful if your contour settings have been changed, or if note spacing 
has changed (for example, after extracting a part). Note that resetting the slur 
contours can result in collisions. 

• Increase slur height by a fixed number. 

• Reset positioning for note-attached slurs to Finale’s defaults. 

• Resolve collisions with articulations (see next paragraph). 

 

Resolving slur collisions with articulations 
Finale 2002’s Engraver Slurs can now avoid collisions with articulations that have the 
option ‘Inside Staff’ checked. If you use that option, the only reason you might still need 
this plug-in is to move other articulations such as accents outside the staff. 
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• Adjustment type 1 
• Adjustment type 2 

TGTools divides the articulations into two groups: articulations with a small height 
such as staccato, tenuto, etc. – adjustment type 1 (flat),  and ones with a bigger 
height such as accents – adjustment type 2. Two different adjustment values are 
specified for each type. 

• Recognize articulation types automatically? Should normally be checked. 
• but ignore these articulation numbers: here, you can specify the numbers (from 

Finale’s articulation selection dialog) of any articulations to be ignored. Separate 
numbers with a comma. 

• Set these articulation numbers to adjustment type 1/2: to override the automatic 
recognition of an articulation height, specify its number in one of these fields. Rarely 
needed! 

• Move these articulation numbers above the slur tip: this is the main option that 
you might still want to use with Finale 2002. Specify the number of your accent 
articulation slot here (for example), and the accents will be moved outside the slurs. 

• Ignore manually or plug-in positioned slurs: using this option, you prevent the 
plug-in to change the positioning of slurs that have already been positioned 
manually or via this plug-in. To reposition all slurs that start or end on notes with 
articulations, uncheck this option. 

• Articulations with vertically off-center handles: some articulations are defined in 
such a way that their handle is off-center. TGTools usually recognizes these auto-
matically, but you may have to specify an articulation number here if you’re using an 
unusual one. A rarely changed option. 

• Correct off-center handles by: off-centered articulations have to be treated 
differently when above the staff from when they’re below the staff. The amount of 
difference is specified here. A rarely changed option. 

 

 

Modify-Enclosures 
This feature can copy or remove text expression enclosures. On the left side of the dialog 
box, you will find a list of all expressions in the document. Currently, all expressions are 
displayed using the same text font, so that you need to identify ‘musical’ expressions such 
as dynamics by the characters typed into Finale’s Expression Designer dialog box. 

In the list, expressions that have keyboard shortcuts are displayed with the shortcut in 
parentheses. In addition, an asterisk is shown next to expressions with enclosures. 

Choose between three possible actions before clicking on Go: 

• Remove enclosures: to remove enclosures, select the expressions from the list, 
place the checkmark next to this option, and click Go. 

• Get enclosure (=Copy): to pick up an enclosure from an enclosed expression, 
select the expression, place the checkmark here, and click Go. 
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• Put enclosure (=Paste): to add (paste) an enclosure that you have just picked up 
(copied), select the destination expression(s), place the checkmark next to this 
option, and click Go. 

 

 

Modify-Shift 
This plug-in currently shifts either of these items: 

• whole notes. You may want to do this in order to make their alignment appear 
centered above or below other notes. Notes longer than whole notes are also affected. 

• grace notes.  In case you don’t like how Finale positions them. 

• note-attached glissandi before accidentals in order to avoid collisions.  

 

 

Modify-Transfer 
This plug-in enables you to transfer (copy & paste) things that Finale can’t normally copy 
itself. Most of these items are intended for copying from one file to another. The process 
involves these steps: 

• place checkmarks next to the items that you want to transfer 

• go into the source file. If needed, select a measure region. Make sure ‘Read now’ 
(=copy) is checked, and hit Go. 

• now go to the destination file. If applicable, make your measure selection there. 
Make sure ‘Write now’ (=paste) is checked, and hit Go.  

You can write (paste) multiple times without having to read (copy) the data each time. Just 
make sure ‘Write now’ remains checked (uncheck ‘Automatically switch …’). 

Check out the dialog box for the many different things that can be transferred in this way. 
The list is continuously being expanded. 
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Chapter Six 
 

New Spacing  

Lyrics Utilities 

 

 
 



TGTools v1.88   

58 

New Spacing 
This command invokes Finale’s Note Spacing. However, to achieve better results, a range 
of preporcessing and postprocessing tricks are performed. Current improvements are 
designed to improve handling of lyrics. 

The following problematic items are addressed by New Spacing: 

• Melismas, 

• Notes that exceed a measure’s length 

• Centering of syllables under whole and double-whole notes 

• Long syllables on beat one 

• Complementary rhythms 

Some of these are also available as separate plug-ins. However, it is often useful to have 
all necessary preparations, including Note Spacing, done by a single command. 

Example 
This is the normal result of Finale’s Note Spacing: 

 

With New Spacing, it looks a little different: 

 

Note 
Since some of the functionality is achieved by automatically invoking other TGTools plug-
ins, these may need to be tested and configured separately before New Spacing can 
produce optimum results. The separate plug-ins are: 

• Left-align melisma syllables (should rarely need modification of options) 

• Shift lyrics - for whole and longer notes (may require tweaking of options since they depend 
on music font preferences) 

• Move long syllables on beat 1 a bit to the right  (options may require modification according 
to text fonts and taste) 
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Lyrics Utilities 
These commands will help you in handling lyrics. There are many situations where Finale 
cannot (yet) handle lyrics automatically, so that manual tweaking is necessary. While 
TGTools cannot relieve you from this, there are a few things that can be automated now. 

Common lyrics problems include: 

• Melismas.  
Both alignment and note spacing for melismas must be improved. 

• Lyrics at the beginning of measures. 
Syllables should often be shifted to the right, and less space be allocated at the 
beginning of measures. 

• Syllable centering under whole and double whole notes. 
Finale’s default behavior is not to center these syllables correctly – especially with 
recent music fonts. 

• Centering of syllables with punctuation marks. 
Syllables followed by any of .,-?! don’t look well centered. 

• Word Extensions 
Finale’s word extension could be improved in some aspects. 

 

Of these, TGTools helps you with the first three problems. TGTools Lyrics Utilities 
currently include: 

♦ Move long syllables on beat 1 a bit to the right 

♦ Left-align melisma syllables (on Finale 98), or 
Move melisma syllables to the right (on Finale 97) 

♦ Lyrics-Remove ... lyrics adjustments, alignment and/or justification settings 

♦ Shift Lyrics 
for example, to properly center them under whole and double whole notes 

♦ Proportionality 
Please see chapter 3 for documentation on this feature. 

 

By using TGTools New Spacing, you can solve many problems with one quick command. 
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Move long syllables on beat 1 a bit to the right 
This will make slight adjustments for longer syllables at the beginning of a measure. 
Moving them to the right a bit will prevent the empty space between the barline and the 
first note from becoming too large when Note Spacing is applied.  

The example shows the music before Note Spacing was used: 

 

 

becomes: 

 

Options 

 

♦ Minimum width of syllables to modify: Since only longer syllables should be shifted 
to the right, a minimum width is specified (in points). The default is 17, which means 
that most syllables that have at least three letters will be affected. 

♦ Proportionality factor: This should only be modified if you find the the adjustment is 
not as you would like it. If you think the syllables are moved to far to the right, use a 
lower value than 100. 

♦ Ignore previous adjustments? If checked, the command will ignore and discard any 
previous horizontal adjustments to longer syllables on beat 1. If unchecked, then 
syllables that already have been adjusted won't be touched at all. 

 

Note: Use this plug-in before applying Note Spacing.  
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Left-align melisma syllables 
or, on Finale 97:  Move melisma syllables to the right. 

The melisma problem is not solved by this plug-in alone (better as part of New Spacing), 
but it may be helpful. You should use it after Note Spacing – otherwise Finale will allocate 
even more extraneous space between the first two melisma notes. 

 

 

    becomes: 

 

In Finale 98 and above, the melisma syllables are left-aligned and left-justified. This 
alignment change will always affect all verses. 

In Finale 97, the melisma syllables are shifted to the right which can be less precise. 

 

Options (Finale 98 and 2000) 
The options dialog as it appears in Finale 98 and above: 

 

♦ Minimum width of syllables to modify: normally, there is no minimum width (0). 
However, if you wanted to process only longer syllables, you could increase this value. 
It is measured in points. 

♦ Additional horizontal displacement: the additional shift will make the syllables look 
properly aligned. You may want to adjust this value to your personal taste. 

♦ Ignore previous adjustments? If checked, the command will ignore and discard any 
previous horizontal adjustments to melisma syllables. If unchecked, then syllables that 
already have been adjusted won't be touched at all. 

 

Options (Finale 97) 
In Finale 97 they are the same as the Options described on the previous page. The only 
difference is that the default minimum width is zero. 
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Lyrics-Remove ... 
Sometimes it is desirable to remove certain items or properties from a selected region, 
without removing any notes or text. In fact, it is possible to remove only one specific 
characteristic and leave all other properties and items alone. If you're not removing 
concrete visible items, you're removing properties or adjustments in order to reset them to 
their default states. 

This command triggers the Remove... dialog box which provides some options that are not 
available in Finale's MassEdit ⇒ Erase... command. It works just like Finale's command, 
but it offers different things to remove from the selected document region. 

All the 'items' offered here are properties – when you remove them, they will be reset to 
their default appearance. 

This dialog is going to be extended by many new items in the future. Currently the 
removable items are: 

Options 

 

♦ Horizontal lyrics adjustments: this option will reset any horizontal tweaking of 
syllables within the selected region. Thus, it will also remove the adjustments made by 
TGTools' Move long syllables on beat 1 a bit to the right. 

♦ Vertical lyrics adjustments: this option will reset any vertical tweaking of syllables – it 
will not remove lyrics baseline adjustments, but only modifications of the vertical 
position of single (or multiple) syllables. 

♦ Lyrics alignment settings (Fin98 only): will reset syllable alignment to Default. 

♦ Lyrics justification settings (Fin98 only): will reset syllable justification to Default. 

Note: this dialog box is accessible from the Lyrics Utilities submenu and the Miscella-
neous submenu, with different default option settings. 
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Shift Lyrics 
This tool can be used to shift syllables within the selected region in both horizontal and 
vertical directions.  

Its original intention is correcting Finale's centering of lyrics under whole and double-whole 
notes. This will be done when using Shift Lyrics with the default options settings: 

 

 

becomes: 

 

To achieve this result, quite a few options are provided so as to: 

• affect notes within a specific range of durations only  
(such as whole and double-whole notes) 

• program different horizontal shift values for different note durations 
(since the required compensation for double-whole notes is wider than for whole notes) 

• handle dotted notes correctly 

Note: the default option settings will correct Finale's centering of lyrics under whole and 
double-whole notes as shown in the example. The first two options may require slight 
modifications depending on the music font used. 

Options 
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♦ Shift lyrics on shortest affected notes horizontally by: here, you specify the 
horizontal shift (in Finale's EVPU measurement) which is used for the shortest notes 
within the range of durations that are modified. 

With the default settings, this is the horizontal correction applied to whole notes. 

♦ Shift lyrics on longest affected notes horizontally by: here, you specify the 
horizontal shift which is used for the longest notes within the range of durations that are 
modified. 

With the default settings, this is the horizontal correction applied to double whole 
notes. 

♦ Shift lyrics vertically by: use this field for vertical shifts. It is not used by the default 
settings (0). 

♦ Minimum EDU length of notes to modify: this specifies the shortest note duration 
whose lyrics are to be shifted. The default value of 4096 will require notes to be at least 
as long as a whole note. 

♦ Maximum EDU length of notes to modify: this specifies the longest note duration 
whose lyrics are to be shifted. The default value of 8192 corresponds to double whole 
notes.  

This value must not be increased without increasing the second option (from top) also 
since these value correspond to each other. 

However, if the following option is on, syllables under dotted whole notes are also 
corrected: 

♦ Auto-handle dotted notes?  when checked, TGTools  will use an additional horizontal 
shift for dotted notes, and it will also include dotted whole notes even though they are 
longer than the specified maximum EDU value. 

♦ Additional horizontal shift for lyrics on dotted notes: this value is used to make 
syllabled look well-centered under dotted whole and dotted double-whole notes. 

♦ Modify syllables which already have adjustments? if this option is not checked, the 
plug-in will not touch syllables that already have horizontal or vertical adjustments, 
whichever applies. 

♦ Ignore these previous adjustments? this option is only available if the previous 
option is checked. If this option is selected also, then previous positioning adjustments 
will be reset prior to shifting. 

With the default purpose of the plug-in, it is recommended to have this option checked 
when the previous option is selected. This will cause TGTools to start over with the 
corrective horizontal syllable adjustments. 
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Chapter Seven 
 

Part Management Utilities 
Process Extracted Parts 

Smart Distribution  
- of grouped parts 

- of multi-part systems 

Add Cue Notes 

Join rests of multiple layers 

Harp Pedaling 
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New way of score and part creation 
Using the new TGTools Part Utilities is a whole new approach: 

1. No special tricks in the score. 

When the score is entered, we don't have to think about having to extract parts.  
We can do all we want to have a beautiful optimized score with constantly  
variable usage of the various staves.  

2. Smart Part Distribution 

which recognizes how we notated the various parts throughout an instrument group's 
systems. 

This part assignment may change often, and everything is allowed: 
- separate parts on separate staves, 
- chords within one layer of a staff 
- several layers per staff 
- using Finale's 2nd voice mechanism - all can be mixed within the same score! 

3. Keyword recognition 

Smart Staff Distribution recognizes staff expression keywords such as "a 2", "1.", "tutti", 
"solo".  

It automatically copies the according notes to the correct parts. 

"1." through "9." are optionally removed from the parts since they are only needed in the 
score. 
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Process extracted parts 
The processor for extracted parts chooses the right notes for one part from a system in 
which multiple parts have been notated. 

This processor has to be run separately on each part and is automatically invoked from 
another plug-in: Smart Distribution of Parts. 

Examples: 
all these were within the same score and the part extraction was done by one command 
per part. 

   score part 1 part 2 

using 2 
2layers: 

   

using piano 
(chord) 

notation:  
  

using voice 2: 
(note that the 
inconsistency 
in the score 

has no 
negative  

effect on the 
parts) 

 
  

 

Using multiple layers or voices 

In the case of multiple layers or voices, it can occur that the second part gets no 
articulations, slurs, staff expressions and the like. 

The option "Secondary parts inherit..." will create 2nd parts with everything copied from the 
first layer or voice. 
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Smart Distribution of Parts 
This plug-in will explode various parts from multi-part staves. It will recognize 
specifications such as 1., 2., tutti, or a2. 

There are two menu items for this funtion: 

• Smart Distribution of grouped parts  
lets you select from a list of groups to process. 

It will process the group as a whole, and the way the various parts are entered within 
the group may vary as needed. Sometimes several instruments are combined on a 
staff, sometimes each part is on its own staff - all possible cases will be detected and 
exploded correctly.  

• Smart Explosion of multi-part staves  
lets you select from a list of staves to process. 

Each staff is processed separately and the number of parts contained each staff is 
considered to be constant throughout the selected measure region. 

 

Note: a few things are required for this plug-in to work properly. 

1. You need to tell the plug-in whether Finale is showing “Defined Measure Numbers” 
or “Actual Measure Numbers” which is set in Finale’s program option.  
The bottommost option of the plug-in’s dialog has to be set accordingly. 

2. In the view menu, “Show Active Layer Only” needs to be turned OFF. 

3. Pickup bars can be a problem. If you get an error message, please make sure that 
the pickup definition in Finale’s Document Opions $ Music Options is correct, or 
distribute the pickup measure manually. 

 

Short Example 

 

 

 

 

  becomes:   
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Screenshot & Options 

 

• In cases of doubt, do single notes default to unisono? 
Normally on. Note that you have to specify "1." or "2." etc. only very rarely because it can normally 
be guessed from the stem directions. So, when there are no a2's, single notes can be set to be 
interpreted as unisono.  

• Secondary layers inherit articulations, slurs, etc. 
When two or more parts have been entered in separate layers, this option will enable inheriting of 
articulations, slurs, and note-attached expressions. Note that this option will affect only measures in 
which the inheriting layer doesn't already have any of these note-attached elements.  

• Ignore layers (i.e. for cue notes) 
The layers specified here are ignored, but they are copied to the exploded staves, too.  

• Align and optimize dynamics 
When on, dynamics are aligned and sometimes shifted up a little. 

• Align each musical phrase independently 
Since dynamics alignment is oriented on the farthest element within each alignment region, this 
option tries to treat musical phrases separated by rests independently.  

• Restart alignment after how many measures without dynamics 
To achieve smaller regions for aligning dynamics, the default of 4 can be reduced. See previous 
option for more information on alignment regions.  

• Remove 1.-9. 
Will remove 1., 2. etc. from the part after having interpreted these specifications.  



TGTools v1.88   

70 

• Remove a2 etc. 
Will remove a2, a3 etc. from the part after having interpreted these specifications.  

• Unfreeze slur directions 
This enables note-attached slurs to recalculate their position (below or above). Will probably result in 
collisions which have to be cleaned up manually.  

• Create new staves  
Normally ON since new staves are often required for the explosion.  

• Leave original staves untouched 
With this option selected, the exploded parts are put into new staves. Otherwise, the original staves 
will be used, too, and fewer new staves are inserted.  

• Maximum number of parts per original staff 
Sometimes the plug-in may think that there are more parts in a staff than you actually put in. To 
prevent this misunderstanding, this option puts a limit to the number of parts per staff. Sometimes, it 
must be increased.  

• Finale’s program option is set to ‘Show defined measure numbers’ 
It is very important to set this option according to Finale’s program options. See Note. 

• Copy Clefs 
Uncheck this if you don’t want clefs to be altered in staves where music is exploded 
to. 

 

 

 

 



TGTools v1.88   

71 

The complete sample score 
with five parts notated in a constantly varied manner (for demonstration purposes) 

 

2. The output 

 

 

 

 

 

 

 

 

 

 
And this is the output of the all-automatic Smart Part Distribution: 
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Add Cue Notes 
This is an improved version of Coda’s original plug-in. 

 

 

Improvements 
" Copies clefs, lyrics, smart shapes, expressions, articulations, and special tools 

alterations. 

" Modeless dialog - the window can be kept open, and you need to access the menu 
only once. 

" Taller staff selection list 

" Places whole note rests into empty measures regardless of time signature 

" Settings are remembered 

Note: 
The "Cue name" field is normally left blank - it does not show the selected instrument 
because the selection may change while the dialog box is open. Leave the field blank if 
you want the selected staff’s name as the cue name. 
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Join rests of multiple layers 
Depending on Finale’s layer options, rests in multiple layers may be positioned at different 
vertical positions to show each layer’s independent rhythm. 

This command will join these rests where appropriate: 

---->  

(no options to set) 

 

Harp Pedaling 
• adds pedal diagrams  

• adds pedal changes as note-attached text expressions. 
These have to be moved left to the desired location manually   

• now supports Matthew Hindson's Harp Pedal font v1.1: 
 

(available for download on the TGTools web site) 

• it can also respell notes in order to optimized pedal usage. This feature is not 
highly developed yet so that manual verification and optimization is necessary. 

 

 

 

http://www.hindson.com/
http://www.tgtools.de/licence.htm
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Chapter Eight 
 

Miscellaneous Utilities 
 

Text Expression Sorter 

Custom Chord Styles 

Character Set Conversion 

Find 

Analyze 

Compare Entries 

Export to Spreadsheet 

Import Auricle Files 

Font Info 
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Text Expression Sorter 
This will sort your text expression library. Alternatively, you can display an instantly sorted 
list with Explorer for Text Expressions (Windows) or Select Text Expression (Macintosh). 
These are the first menu item in the TGTools menu, but there is currently no PDF 
documentation on them. 

In addition to sorting, this plug-in can delete unused text expressions. 

 

Custom Chord Styles 
With this plug-in, you can convert chords entered in a Finale document to various different 
chord styles that itself Finale does not support: 

• a style where the letters Bb (for B flat), H (for B natural), and H# are used. 

• Italian style: DO RE MI HA SOL LA SI 

• or user-defined style. 

The conversion is done by having Finale not display the chord root, and moving it 
converted into a newly created suffix. Converted chords do not transpose! 

 

Character Set Conversion 
This plug-in will convert the special characters between the Windows and Macintosh 
character sets. You can also define your own conversion. Click the default button to fill the 
dialog with the necessary Mac and Win characters. 

 

Find 
A useful utility that displays measure areas where certain items are found. You can look 
for: 

• all measures with entries (for example, to instantly find and jump to the measures 
where a given instrument is used in the score) 

• Enharmonic oddities (the same pitch repeated, but notated differently, which may 
indicate wrong clefs). 

• Text Expressions – just enter part of or or the complete expression. You can also 
specify that it must be a music font. 

When measures have been found, click on them in the selection list to jump to that 
location in the score. 

 

Analyze 
This musical analysis plug-in currently finds parallelisms. With Finale 2000 or newer, it can 
mark them in the score using note-attached glissandi. Older versions of Finale will show 
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the parallelisms using diamond noteheads. Various options control what kinds of 
parallisms are detected. 

 

Compare Entries 
This utility can compare music in two different staves or different files. It is mostly used to 
find the differences in two versions of the same file. 

When differences have been found, click on them in the selection list to jump to that 
location in the score. 

You can also have the changes/differences marked in the score. There are several 
different abbreviations that are used, they are pretty technical: 

FEWER – fewer enties 

MORE – more entries 

DUR – duration 

NOTE – note 

ARTIC – articulation 

EXPR  – text expression 

DIFF  – other differences 

EF – entry flag (entry properties) 

NF – note flag (notehead properties) 

 

Export to Spreadsheet 
This plug-in will create a text file with a numeric representation of the music. That text file 
can be imported intro spreadsheet applications in order to perform numerical analysis of 
the music. 

 

Import Auricle Files 
This imports information from Auricle cue files saved as text. Needed only if you’re using 
the film synchronization software Auricle. 

 

Font Info 
Shows all fonts referenced in the document. Note that some fonts will probably be listed 
that are referenced but not actually used. 
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